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Spreadsheets

You will learn about some important features of 
Excel.

Online MS-Office information source: 
https://support.office.com/

Getting Started: Creating A New Blank SpreadSheet 
(Excel: “Workbook”)

• Once Excel has started, select the option for creating a new 
sheet:

Select this for  

CPSC 203

https://support.office.com/
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Spreadsheets 101 (Basics)

Row 
numbers

Column 
headingsCoordinates of 

current cell

Contents of 
current cell

Current cell

Entering Data

• Click on cell to enter the data (in the example: selected cell A1)

• Type in cell contents (data entered in the example: ‘Student’)
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Contents Of A Cell: Types

• Raw data: also referred to as ‘constants’

• Labels: describe the contents of another cell

• Formula: values derived from the raw data (e.g., calculations: 
=2+2, lookup values: =D2*2, functions: =sum(B2,B9))

Distinguishing Formulas From Text

• In Excel all formulas must be preceded by the ‘=‘ symbol 
(“assignment operator”) to distinguish it from text.

• Example spreadsheet: 1_formulas
– Label

2 + 2

– Formula

= 2 + 2

For the sake of brevity, you can assume that all formulas in this 

section will be preceded by the assignment operator ‘=‘
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Entering A Formula That Refers To Another Cell Or Cells

• Approach 1: type it all in all 
– Click on a cell where you want to enter the formula e.g. click on C2

– Type in the formula manually e.g. type =A2*B2

• Approach 2: type and click
– Click on a cell where you want to enter the formula e.g. click on C2

– When you get to the part of the formula that refers to another cell then 
just click on the cell (being referred to) rather than typing in the cell 
address e.g. click on A2 after typing the ‘=‘ in C2

2)  Reference to Cell 
A2 appears here

1) Click 
here

Formatting Cells

• For other information for the other tabs (right clicking on a cell 
to ‘format cells’)
– Similar to the basic features of Word these features will be assumed prior 

knowledge or knowledge that students can pick up on their own.

– These features won’t be covered in lecture nor will they be covered in 
tutorial.

– For more information please refer to the tutorial notes: 
“excel_basic_features”.
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Basic Mathematical Operators

• Example spreadsheet: 2_operators

Mathematical 
operation

Excel operator Example

Assignment = = 888

Addition + = 2 + 2

Subtraction - = 7 – 2

Multiplication * = 3 * 3

Division / = 3 / 4

Exponent ^ = 3 ^ 2

• Operations on a higher level are evaluated first
8 / 2 ^ 3 Equals 8 / 8 or 1

• When a sequence of operators from same level (e.g. addition, 
subtraction) are encountered in a cell the expression is 
evaluated from in order in which they appear (left to right).
2 + 2 - 1 Equals 4 – 1 or 3 

Order Of Operation

Level Operation Symbol

1 Brackets (inner 
before outer)

()

2 Exponent ^

3 Division,
Multiplication, 

/
*

4 Addition, 
Subtraction

+ -
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Designing Spreadsheets: Rules Of Thumb

1. Do not directly enter values as data that can be derived from 
other values (this is a numerical calculation example)

– Example

•Assignment grade (assume one assignment worth 40%) = 4.2 (data in cell A2)

• Exam grade (assume only one exam worth 60%) = 3.3 (data in cell B2)

• Calculate term grade point =(A2*0.4)+(B2*0.6) OR directly enter 3.66?

4.2 3.3 =(A2*0.4)+(B2*0.6)

A2 B2

Designing Spreadsheets: Rules Of Thumb (2)

1. Do not directly enter values as data that can be derived from 
other values (the ‘&’ operator connects text)
•Example: 3_generating_honorifics

=A2 & " " & C2

=A2 & " " & B2

In Excel the ampersand ‘&’ 
connects text strings

Manually 

entered 

data

Generated 

(and 

updated) 

according 

to the data
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Designing Spreadsheets: Rules Of Thumb (3)

2. Label information so it can be clearly understood

Designing Spreadsheets: Rules Of Thumb (4)

3. Never enter the same information more than once
Example spreadsheet: 4grades_formulas

•Advantages: reduces size and complexity of the sheet, making changes can be 
easier.

• Seems obvious? Not always

• Example: What if the previous spreadsheet were used to calculate the grades 
for a class full of students?

• Some would create the sheet this way:
=(B2*0.4)+(C2*0.6)

=(B3*0.4)+(C3*0.6)

Etc.
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Designing Spreadsheets: Rules Of Thumb (5)

– Issues:

•Making changes: What if the value of each component (40% assignments, 60% 
exams) changed?

–Retyping/modifying all formulas is inefficient (at least a copy-paste is needed)

• Clarity: What does the 0.4 & 0.6 refer to (sometimes it’s not so obvious)? It 
violates the “label information” rule of thumb.

=(B2*0.4)+(C2*0.6)

=(B3*0.4)+(C3*0.6)

Etc.

Lookup Tables

• Example spreadsheet: 5_grades_lookup

• As the name implies it contains information that needs to be 
referred to (“looked up”) in a part of the spreadsheet.

• Can be used to address some of the issues related to the 
previous example:
– Clarity

– Entering the same data multiple times

=(B2*$G$2)+(C2*$G$3)
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Quick Hint #1: When To Use the $ Sign (Absolute Cell 
Reference)

• If a formula always refers to the same location in the spreadsheet (e.g. 
lookup table or lookup cell)

• Always precede references to cells being looked up with a dollar sign

– Values in G2 and G3 are needed in calculations for all students so the row and 
column are preceded by a dollar sign: (B2*$G$2)*(C2*$G$3)

– The dollar signs ensure that when the formula is copy-pasted, other student’s 
term grade points always refers to grade weightings specified in the lookup table 
defined in Cell G2 and Cell G3.

=(B2*$G$2)+(C2*$G$3) Changing the lookup table values 

automatically changes all cells that refer 

to the table (i.e. term GPAs update)

Quick Hint #2: When NOT To Use the $ Sign (Relative 
Cell Reference)

• If a formula will refer to different cells if it is copy-pasted (or 
moved) to another part of the spreadsheet.
– E.g. assignment and exam GPA used to calculate term grade.

=(B2*$G$2)+(C2*$G$3)Original formula

=(B3*$G$2)+(C3*$G$3)Formula copied 
down 1 row 
(row +1)
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Relative Cell Reference: No $ 
Sign

• General rule:
– If the formula is moved/copied ‘down’ by ‘a’ rows then the relative row 

references increases by ‘a’ amount.

• Previous example: formula is copied down by 1 row so the cell references 
increased by 1: from B2 to B3 (+1) for the assignment component and from C2
to C3 (+1) for the exam component.

• Thus the formula changed:

–From: =(B2*$G$2)+(C2*$G$3)

–To: =(B3*$G$2)+(C3*$G$3)

– If the formula is moved/copied ‘up’ by ‘a’ rows then the relative row 
references decreases by ‘a’ amount.

– If the formula is moved/copied ‘left’ by ‘c’ rows then the relative cell 
references decreases by ‘c’ amount.

– If the formula is moved/copied ‘right’ by ‘d’ rows then the relative cell 
references increases by ‘d’ amount.

Relative Cell Reference: Errors

• If a relative cell reference produces a row or column reference 
outside the valid range (e.g. below ‘A’ or ‘1’) an error message 
will appear.

• Example: copy the relative cell reference from D3 to D1.

– The new formula would refer to Cell =B1 minus two rows (not possible).

• Maximum number of cells in an Excel spreadsheet1

– 1,048,576 rows by 16,384 columns

– (This information is included for your own reference rather than 
something you should know as a requirement for the exam).

1 Source: https://support.office.com/en-us/article/excel-specifications-and-limits-1672b34d-7043-467e-8e27-269d656771c3

https://support.office.com/en-us/article/excel-specifications-and-limits-1672b34d-7043-467e-8e27-269d656771c3
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Cell References: Example Exam Question

• What’s the result of copying the expression from F3 to G4?

• Note: References to empty cells (e.g. B1) that are used in a 
mathematical expression return 0.
– Example B1 + C1 = 0

Data Too Big For Your View

• Covered in this section of lectures notes
– Freezing panes

– Simple merging of cells (merging cells on a single row).

• Covered in the introductory tutorial notes
– Resizing rows or columns

– Wrap the data

– Merge data (merging multiple rows as well as multiple columns)
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“Freezing” Panes: How/Why

• Often used to lock the view so labels always stay onscreen 
regardless of which part of the sheet you are viewing.

• Obviously this is useful for cases that contain column (or row) 
headings.

• Running the Freeze Panes feature: View -> Window: 
Freeze Panes

Freezing Panes: Effect On Example Spreadsheet
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Freeze Panes: Procedure

• Move to the row below the row to be ‘frozen’.

• In the previous example with student grades it would be Row 
3.

• Select: 
– View -> Window : Freeze Panes and then select the “Freeze 
Pane” option among the options.

Merging The Columns Along A Single Row

• Combines the columns into one wider column.

• Before the merge

• (Merging Row 1: Col A – E)

• After “Merge & Center” (merge and center align)

• After the Merge Across, Merge Cells (merge and retain 
previous  alignment settings)
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Merge Columns (Each Containing Data)

• Only the data in the top left-most cell of the merged range is 
retained.

• Before the merge.

• After the merge: Merge and center (“L01” is lost)

• After the merge: Merge across, Merge cells (data “L01” is lost)

Copy-Paste: Explanation

• A single cell or a range of cells can be copied (or cut) and 
pasted.

• There are a number of options for how the originating cell or 
cell is pasted into the new location.

• We will cover a few of the options for this class
– “Paste”: copies the formula (which may be modified if the cell references 

are relative)

•May update final values if the data changes (relative references used).

– “Paste values”: includes only data or the final result of a formula. 

• If the formula changes then the pasted data won’t be updated.

– “Paste link”(always updates to the current value in the source cell)
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Copy-Paste: Example

• Example spreadsheet: 6_copy_paste
– Copy paste from A3 into C3 (paste current formula), D3 (paste current 

data), D3 (paste link)

– Changes in data in the source cell: if the values in A5 & B5 change to 9
and 6 respectively what will the values be in C3, D3, E3 and why.

– Changes in the formula in the source cell: Contents of A3 was changed to  
=9*3

=$A$5*$B$5

=$A$5*$B$5
56 =$A$3

Copy-Paste

• For your information: Multiple cells (an entire row, column or 
even a range of cells e.g. A1:C10 can by copied-pasted)
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Autofill

• Allows for a sequence (constant or addition by a constant 
amount) to be extended
– E.g., The sequence “1, 2, 3” (can be extended to include “…4, 5, 6”)

• Steps:
1. Highlight the cells containing the sequence to extend (selecting one cell 

just repeats the contents of that one cell).

2. Move the mouse pointer to the ‘handle’ at the bottom right

Autofill (2)

3. Drag the mouse as far down as you wish the sequence to be extended 
to.
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Autofill (3)

• It’s best to only extend a sequence that only employs addition 
(e.g. +1, +3, -1, -10) or a constant sequence using autofill 
handles.

• To extrapolate other sequences (e.g. multiplication) don’t use 
autofill:
– https://support.office.com/en-us/article/project-values-in-a-series-

5311f5cf-149e-4d06-81dd-5aaad87e5400

Autofill: Practice

• What would be the autofill result of the following.

E.g.1 E.g. 2

https://support.office.com/en-us/article/project-values-in-a-series-5311f5cf-149e-4d06-81dd-5aaad87e5400
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Terminology

• Spreadsheet (referred to as a “workbook” by Microsoft)
– A Microsoft Excel file

• Worksheet
– A part of a spreadsheet

• Each spreadsheet can consist of multiple worksheets.

– Example:
• Spreadsheet: all my CPSC 203 grades for the CPSC 203 fall 2008 term.

• Worksheets for each of the two lectures taught by this instructor that term.

Worksheets

Worksheet

Spreadsheet

Create new 

worksheet
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When To Use Multiple Worksheets

• Rules of thumb:
– When there are multiple sheets of related information, each group of 

information can be stored in it’s own worksheet (self contained)

Grades for lecture 01

(worksheet)

Grades for lecture 02

(worksheet)

Grades for lecture 03

(worksheet)

Grades for all sections(spreadsheet)

Budget for dad 

(worksheet)
Budget for mom

(worksheet)

Budget for sunny-boy

(worksheet)

Family budget (spreadsheet)

When Not To Use Multiple Worksheets 

• If the information consists of groups of unrelated information 
then the information about each group should be stored in a 
separate spreadsheet/workbook rather than implementing it a 
spreadsheet with multiple worksheets.

Grades for 

mom 

(spreadsheet)

Expenses for 

the family 

business 

(spreadsheet)

Daily calorie 

intake for dad 

(spreadsheet)
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Referring To Other Worksheets

• One worksheet can refer to information stored in another 
worksheet.

• Example spreadsheet:
– 7_multiple_worksheet_example

JT’s tip:
• For more complex examples you might 

want to take extra “in-class” notes.
• (It could be hard to understand the 

concepts at a level sufficient for the exam 
or remember notation/symbols if you just 
look at the slides).

References Between Spreadsheets

• In a fashion similar to using multiple worksheets, one 
spreadsheet can refer to information stored in another 
spreadsheet.

• Example spreadsheets:
– 8A_multiple_spreadsheet_example

– 8B_multiple_spreadsheet_example
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=A2*'[8B_multiple_spreadsheet_example.xlsx]AB rates'!$A$2

8A 8B

Why Use Cross References?

• Cross references:
– a worksheet refers to another worksheet,

– a spreadsheet refers to another spreadsheet,

• …may be used when:
– the second worksheet or spreadsheet contains data 

that needs to be “looked up” (e.g., a lookup table)

• Some examples where cross reference 
lookups may be needed:
– Grade cutoffs

– Tax brackets

– Product numbers (lookup a product number to get 
more information about the product)
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Data Validation

• Ensures that the data falls within a valid range (e.g. Age must 
be 0 – 116) or that a specific type of data is entered (e.g. whole 
number only).

• Invoking:
– Data->Data Tools: Data Validation

• Example spreadsheet: 9_data_validation
– Name: no restrictions e.g. “James Tam”, “James Tam  2”, “James 
Goldstein-Chan” “James.org”

– Age: number years (whole number) from 1 – 116

– Income: can include any value from $0.00 - $1,000,000.00 (cents can be 
entered)

– Make sure you include good error messages when setting up data 
validation rules..

• Tell the user what range of values and/or the type of values that can be entered.

Data Validation Example: Name

• No restrictions on input (this is the default in Excel)
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Data Validation Example: Age

• Age must be a whole 
number from 1 – 116.

• Tools to prevent errors in 
input
– Restricting the input

– Tooltip help before data 
entry

Data Validation Example: Age

• A tool to react after bad data 
has been entered.
– Popup error message appears 

after the input restrictions have 
not been met.
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Data Validation Example: Income

• Income allow for any value from $0.00 - $1,000,000.00 (cents 
may be entered – this is a clue that the input should not be 
restricted only to whole numbers).

Pre-Created Excel Formulas
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What Function Is Right For Your Situation?

• Excel provides reminders.

• Built in functions are grouped into the ‘formulas’ tab on the 
ribbon

• Also Excel provides “name completion” and “tool tips”

Input Format For Excel Functions

• Required input is typically a range of cells
– Format:
=FUNCTION(<start cell> : <end cell>)

– Example:

=AVERAGE(A1:A3)

• Alternatively input may be fixed inputs (type data directly into 
the brackets)
=AVERAGE(20,30,10)

• Optional function inputs (“arguments”)
Distinguished by the use of square brackets [optional 
argument]

=IF (<condition to check>, 

<return value: condition true>, 

[<return value: condition false>])

For the exam 

you can see 

either form
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Basic Statistics

• Example spreadsheet:
– 10_basic_statistics

• Example formulas: SUM(), AVERAGE(), MIN(), MAX()

• General usage:
– Each formula requires as input a sequence of numbers

– E.g., formula(1,2,3):

• Sum = 6 , =SUM(1,2,3)

• Average = 2 , =AVERAGE(1,2,3)

• Min = 1 , =MIN(1,2,3)

• Max = 3 , =MAX(1,2,3)

Basic Statistics (2)

• Referring to a range of cells

=SUM(C3:C7)
=AVERAGE(C3:C7)
=MAX(C3:C7)
=MIN(C3:C7)
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Basic Statistics (3)

• FYI: Ranges can span multiple rows and columns

=SUM(C3:E7)

Counting Functions

• All of these functions tally up the number of cells that do or do 
not contain a certain type of data e.g., numbers, blank cells…

• General usage:
FUNCTION(<start cell range> : <end cell range>)

– An array (list) of inputs can be the function argument but this is rare 
except for illustration or examination purposes e.g., =COUNT(1,"A",2)
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Counting Functions: COUNT()

• Counts the number of cells within the specified range that 
contain a numeric value.

• https://support.office.com/en-US/article/COUNT-function-A59CD7FC-B623-4D93-
87A4-D23BF411294C

=COUNT(C13:C16)

Q: What is the result?

Counting Functions: COUNTA()

• Counts the number of cells within the specified range that 
aren’t empty

• https://support.office.com/en-US/article/COUNTA-function-7DC98875-D5C1-46F1-
9A82-53F3219E2509

=COUNTA(C13:C16)

Q: What is the result?

https://support.office.com/en-US/article/COUNT-function-A59CD7FC-B623-4D93-87A4-D23BF411294C
https://support.office.com/en-US/article/COUNTA-function-7DC98875-D5C1-46F1-9A82-53F3219E2509
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Counting Functions: COUNTBLANK()

• Counts the number of empty cells within the specified range
• https://support.office.com/en-US/article/COUNTBLANK-function-6A92D772-675C-4BEE-

B346-24AF6BD3AC22

=COUNTBLANK(C13:C16)

Counting Functions: Spreadsheet Example

• Example spreadsheet: 11_counting_functions

– COUNT(): Also used in Row 10

– COUNTBLANK(): Also used in Row 11

=COUNT(C3:E7)

=COUNTBLANK(C3:E7)

https://support.office.com/en-US/article/COUNTBLANK-function-6A92D772-675C-4BEE-B346-24AF6BD3AC22
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Counting Functions: Spreadsheet Example (2)

– COUNTA(): Number of  cases where the employee name has been 
entered into the system.

• That is, blank cells can be either for unstaffed positions or cases where the 
name of the staff member has not yet been entered.

=COUNTA(B3:B7)

Lookup Functions

• One common use of a lookup function is to determine which 
category that some numeric value resides.

• Membership in a category is often determined by ranges:
– Mapping raw scores to a letter grade.

– Determining your ‘tax bracket’.

– Evaluating your “FICO” credit score.
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Lookup Tables

• Lookup functions require a ‘lookup table’ that specifies the ranges.

– Example: for your given grade in a course, a lookup table specifies the various 
cutoffs for the different letter grades.

– Similar to a lookup table containing constants but these examples are for a range 
of values (there are strict requirements in the format) rather than a single value.

• Important format requirements for the first column of the lookup table 
examples covered this term:

– table values must be in ascending order,

– column values can only be numeric.

• In the example the data in cells D11 – D15 follow these requirements.

Example: Specifying Conditions

income>=0 
and <10? 

“Terrible”True

False

income>=10 
and <25?

“Poor”True

False

income>=25 
and <50? 

“Adequate”
True

False

income>=50 
and <100? 

“Excellent”
True

False

income>=100? “Terrific”
True

According to the 
values in this table: a 
numeric value<0 is 
an error condition
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VLOOKUP

• Official link for help
• https://support.office.com/en-US/article/VLOOKUP-function-0BBC8083-26FE-4963-8AB8-93A18AD188A1

• Format:
VLOOKUP(<Lookup value>, 

<Lookup table  Start : End>,  

<Lookup table Column specifying the return value>)

• Example:
=VLOOKUP(B2, D11:E15, 2)

Cell: 
Contains value to find in 
table e.g., a grade point

Lookup table:
Start : End 
cell coordinates

Lookup table:
Column value to return, for 
this example:
(1 = first col. = ‘D’, 
2 = second col. = ‘E’)

VLOOKUP: Investments

• Example spreadsheet: 12_vlookup

=VLOOKUP(B2,D11:E15,2)

Col D (1st) Col E (2nd)

Min income Comment

0 Terrible

10 Poor

25 Adequate

50 Excellent

100 Terrific

11

12

13

14

15

https://support.office.com/en-US/article/VLOOKUP-function-0BBC8083-26FE-4963-8AB8-93A18AD188A1
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VLOOKUP: Multi-Column (3+) Lookup Table

• Name of example spreadsheet: 
13_vlookup_multiple_columns

Lookup function

Excellent

Lookup table

Col 1 Col 2 Col 3

Conditional Counting Function

• Increases a tally count if one or conditions have been met

• COUNTIF()
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Conditional Counting Function: COUNTIF()

• Counts the number of cells that meets a particular 
requirement
– How many employees of a multi-national corporation are Canadian?

– How many students in a class were awarded an “A+” grade?

– Example below: Count the number of cells within the range that contain 
a positive numeric value.

– https://support.office.com/en-US/article/COUNTIF-function-E0DE10C6-F885-4E71-ABB4-1F464816DF34

=COUNTIF(A1:A3,">0")

Conditional Counting Function: COUNTIF(), 2

=COUNTIF(A1:A3,"B")

https://support.office.com/en-US/article/COUNTIF-function-E0DE10C6-F885-4E71-ABB4-1F464816DF34
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COUNTIF(): Full Example

• Example spreadsheet: 14_countif

• Conditions tallied
– Which employees met quota? (If the cell contains “Yes”)

– Which employees had sales that were deemed as high (above $100,000)

=COUNTIF(B2:B7,"YES")

=COUNTIF(C3:C8,">100000")

Recall: From Word Mail Merge Filters

• Example Mail merge filters covered previously
– Filter rule based on age:

• 65 and over:  “You get a seniors discount.”

•Under 65: “No seniors discount.”  

• The If-Then-Else filter checks if a condition has been met 
e.g. a field in the spreadsheet data source was equal to some 
value.
– If the condition has been met (condition = true) then display a message.

– If the condition has not been met (condition = false) then display another 
message.



9/18/2020

Excel spreadsheets 36

New Terminology

• A Boolean expression takes a condition (a comparison such as 
degree being equal to ‘B.Sc.’’) as input and returns a Boolean 
value.
– The conditions must be specified to yield either a Boolean result.

• Boolean / Boolean value: must be either true or false

– Examples of statements that must be true or false: 

•A job applicant has been awarded a B.A. degree.

• The customer is a senior citizen.

• It is below freezing [freezing point of water] today.

The result of this comparison is Boolean (the 
condition can only be met or not met).

Format: IF-ELSE

• Format:
=if (<Boolean expression>, 

<Boolean return value: condition true>, 

[<Boolean return value: condition false>])

– Reminder: square brackets [] is the notation used by Microsoft for optional 
arguments

• Example:
=IF (B2>=100,"GO!","Don’t’ waste your $")

• Official help link
• https://support.office.com/en-US/article/IF-function-69aed7c9-4e8a-4755-a9bc-aa8bbff73be2?CorrelationId=6aeb3056-a94b-47ac-af6e-90dff250a029

https://support.office.com/en-US/article/IF-function-69aed7c9-4e8a-4755-a9bc-aa8bbff73be2?CorrelationId=6aeb3056-a94b-47ac-af6e-90dff250a029
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Excel IF-Function: Investing Example

• In column ‘C’ the sheet will display “GO!” if net income is 100 
(millions of $)  or greater “Don’t waste your $” otherwise.

– Example spreadsheet: 15_if_invest_or_not

=IF   (B2>=100, "GO!", "Don’t’ waste your $")

Boolean expression

Return: condition true Return: condition 
false - “else case”

Comparators

Mathematical
representation

Excel 
representation

Meaning

< < Less than

> > Greater than

= = Equal to

≤ <= Less than, equal to

≥ >= Greater than, equal to

≠ <> Not equal to
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Example Return Values

Type of return value Example return 
value

Example use

Text “GO” =IF (B2>=100,"GO!", "No go")

Numeric 4, 4.0 =IF (C3="A+",4.3, -1)

Cell reference A2, A3 =IF(A1>0,A2,A3)

Boolean True, False =IF(1>2,True,False)

)

IF: Specifying Only The True Case (Poor Approach)

• Example spreadsheet:
16_if_else_invest_or_not_NO_FALSE_return

• If only a return value for the true case has been specified:
– When the condition has not been met (False result from the Boolean 

expression)…literally the text “FALSE” will be displayed.

=IF(B4>=100,"GO!")
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• Example spreadsheet: 17_if_else_invest_or_not_ammended

• Consequently: 
– When a message is desired only when the ‘if condition case’ is true then 

something, even an empty message, should be specified for the ‘else 
return case’ (false that the condition has been met).

IF: Specifying Only The True Case (Better Approach)

=IF(B4>=100,"GO!","")

Logic: What You Learned

• You were informally taught the AND as well as the OR logical 
operations in the section covering Internet searches.

• Example: 
– “James Tam” Calgary Logical AND (default)

– Vs.

– “James Tam” OR Calgary Logical OR

• More formally: AND, OR are logical operators

• Mathematical operators take numbers as input and return a 
number

• New term: Logical operators take a Boolean as input and 
return a Boolean value.
– Logical operators can connect compound (2+) Boolean expressions.

– (Boolean expression) Logical operator (Boolean expression) etc.
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Logical AND: All Restrictions

• Used when all conditions / Boolean expressions (BE) must be 
true

• Example: 
– Prerequisites for CPSC 233: Introductory programming course as well as 

discrete math (“as well as” = AND in this case).

– Intro programming grade >= C- AND  Math grade >= C-

– If either course grade is not satisfactory it’s false that the requirement is met. 

• With Logical-AND if any Boolean Expression is false then the entire compound condition 
is made false.

– Only if all course grades satisfactory will it be true that the pre-requisites have 
been met.

• With Logical-AND only if all conditions are true will the entire compound condition be 
true.

Condition 1 / 

BE 1

Condition II 

/ BE 2

Logical AND: Many Conditions

• To evaluate the result just extend the general rule:
– Multiple AND-expressions must all be true for the overall result to be 

true.

– If at least one expression is false then the overall result is false.

• Example: 
– Internet search: “James Tam” CPSC Calgary

• Before a webpage appears as a search result, all three conditions must be met 
(the three text phrases must appear in that page).

–The more search phrases that you include, the more narrow will be your results (fewer).

– A course with 3 or more prerequisites.

– Job applicants must meet 3 or more requirements e.g. Applicant must be 
an adult, awarded a university undergraduate degree (or a superior 
degree), overall grade point from that degree must be at least 3.0.
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Logical OR: At least One Restriction

• Used when at least one condition / Boolean expression (BE) 
must be met (true).

• Example: 
– Prerequisites for CPSC 233: One of CPSC 217 or 231

– CPSC 231 GPA >= C- OR CPSC 217 GPA >= A-

– If at least one of: CPSC 217, 231 was completed satisfactorily, then the intro 
programming requirement was met.

• With Logical-OR if any condition / Boolean Expression is true then the entire compound 
condition is made true.

– Only if no courses were completed satisfactorily then the programming 
requirement has not been met.

• With Logical-OR only if all conditions are false will the entire compound condition be 
false.

Condition 1 

/ BE 1

Condition 2 / 

BE 2

Logical OR: Many Conditions

• As was the case with Logical-AND to evaluate the result just 
extend the general rule:
– If at least one expression is true then the overall result is true.

– Multiple OR-expressions must all be false for the overall result to be 
false.

• Example: 
– Internet search: “Wayne Gretzky” OR “The Great One” OR “Number 99” 

OR “Number ninety nine”

•A website that includes at least one of the text phrases will be shown as a 
search result.

–Increasing the number of OR-expressions will broaden (increase) the number of search 
results.

– A course with a choice of prerequisites.

– Job applicants can be awarded one of a number of degrees e.g. B.A., 
B.Comm, B.Sc. etc.
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Mixed Logical Expressions

• AND, OR conditions can be combined in actual usage.

• Example: 
– Internet search: “Wayne Gretzky” OR “The Great One” OR “Number 99” 

OR “Number ninety nine” AND “Edmonton Oilers”

•A website will show as a search result if it contains at least one of the three 
‘names’ as well as containing the text “Edmonton Oilers”.

– Course prerequisites: CPSC 233 requires one of: CPSC 217, 231 as well as 
Math 271

• In actual usage logical operators may be implicit so you should be able to 
interpret plain English descriptions in an assignment or during an examination.

• CPSC 217 OR CPSC 231 AND MATH 271

•With logic and software ‘AND’ is a higher order precedence than OR so the 
above is not evaluated left-right, the above is the same as:

–CPSC 217 OR (CPSC 231 AND MATH 271)

• (CPSC 217 OR CPSC 231) AND MATH 271     (To avoid confusion bracket 
expressions to make things explicit).

Logical Functions In Excel

• The basic logical operations: AND, OR can be invoked as 
functions in Excel
– Similar to evaluating logical expressions on paper, all Excel logical 

function inputs can only be a True or False value.

– Function inputs can be: 

• Boolean constant e.g. AND(True,False,False)

• Boolean expression e.g. OR(A1>0,A2>0,3>2)

•A cell that contains a Boolean value e.g. AND(A1,A2), OR(B1,Z2)

• Format:
AND(<True or False>,<True or False>...)

OR(<True or False>,<True or False>...)
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Types Of Inputs: Logic Functions

• Examples (spreadsheet name: 18_logic)
AND(C1>=45,D1="John Smith")   

OR(C1>=0,D2>=0)               

New Terminology: Nested Calculation

• Nested calculation: one calculation is nested within another 
second calculation when the result of the first calculation is 
used to determine the result of the second calculation.

• Simple example:
– Calories expended = (height + 7) * 100

• More complex example:
– First calculation: determine the total cost of salaries and other 

expenditures for each Canadian province.

– Second calculation: determine total for all sources of revenue for each 
province.

– Third calculation: calculate the surplus (of deficit) for each province
= (sum all provincial revenues) – (total provincial expenditures)

– The calculations for revenues and expenditures are nested within (part 
of) the calculation for the surplus (or deficit)
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Nested Functions

• The return result of one function is used as an argument for 
another function.

• Example:
– Find the maximum grade for each lecture section.

– Example:

• Lecture 01: =MAX(A2:A101)

• Lecture 02: =MAX(B2:B101)

– Calculate the average of the lecture maximums

•Average of the maximum scores: = AVERAGE(MAX(A2:A101),
MAX(B2:B101))

=MAX(A2:A101) MAX(B2:B101)

=AVERAGE( ,     )

Using One Function’s Return Value As Input For 
Another Function (Nesting Functions: Logic, IF)

• Breaking down the process into parts
1. Call a function and that function returns a 

value e.g. B4 = 3.7, C4 = 4

2. Use the return value of the first function as 
part/all of the input of a second function

• The first function is nested within the second 
function.

AND(B4>=3.7,C4>=5)

Returns False

=IF(  , "H","")

Actual formulation of the function
IF(AND(B4>=3.7,C4>=5), "H","")
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Logic And IF’s: Example

• Being on the Dean’s list requires: a grade point of 3.7 or higher 
and a full load 5 or more courses.

• AND Excel example: Dean’s list
– Signify when a student has made the Dean’s list requirements with an 

“D”, blank cell otherwise.

• Example spreadsheet: 19_if_with_logic

=IF(AND(B4>=3.7,C4>=5),"D","")

Logic And IF’s: Example (2)

• OR Example: Hired if at least one requirement has been met:
– work experience of 5+ years, 

– grade 3.7 or higher

– (Same spreadsheet as previous example)

=IF(OR(E12>=5,G16>=3.7),"1+ requirement met","")

E12

G16
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Conditional Formatting

• Example spreadsheet: 21_conditional_formatting

• It can be used to visually highlight data which has met a certain 
condition.

Setting Conditional Formatting

• Home Tab-> (Styles group: Conditional formatting)

– With the previous example select: 

• “Greater Than”

• Enter 99999.99 with “Light Red Fill with Dark Red Text”

If you don’t know much 
about visual design then 
keep it simple, stick to the 
basics!
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Ways Of Graphically Representing Information

• Pie chart

• Bar graph
– Excel: Column (vertical), 

bar (horizontal)

• Line graph

Pie Charts

• Good for showing proportions, how much of the whole does 
each item contribute. 

• It’s poor for showing exact numeric values.

Grade distribution

F

D

C

B

# of students receiving each 

grade

F

D

C

B

A
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Bar And Line Graphs

•For showing trends

•Comparing functions

Productivity for 2003
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Creating Graphs Using Excel: Specifying Data

• Select the range of cells
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Creating Graphs Using Excel: Inserting Graph

• Insert-> (Charts Group: Type of graph e.g. 2D Column)

Creating Graphs Using Excel: Choosing Specific Data

• To select non-adjacent columns select the first column, press 
and don’t release control and then select the next column.
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Editing The Graph Title (And Other Parts)

Rules Of Thumb For Graphs

1. What type of graph to use:

a) Bar graphs are used to plot non-continuous data e.g., the 
number of patients that go to different hospitals.

b) Line graphs are used to plot continuous data e.g., mortality 
trends over time.

2. JT: Avoid or minimize the use 3D graphics! Keep things 
simple.
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After This Section You Should Now Know

• The benefit of electronic over paper spreadsheets

• Spreadsheets 101: The basic layout and components of a 
spreadsheet

• Entering data: manually and via autofill

• Raw data vs. labels vs. formulas
– How formulas are distinguished from text

– Entering formulas that refer to other cells

• Common mathematical operators and the order of operation

• The three rules of thumb for designing spreadsheets
1. Don’t make something data if it can be derived

2. Label everything so it can be understood

3. Don’t duplicate data

After This Section You Should Now Know (2)

• Lookup tables
– How to create and use a lookup table

– Includes lookup tables with constant values and lookup tables to be used 
in conjunction with lookup function

• When to use absolute vs. relative cell references in formulas
– How do formulas using absolute vs. cell references change when copied 

elsewhere

• Ways of changing views when the data is too large for the 
display
– Freezing panes

– Merging cells
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After This Section You Should Now Know (3)

• Different forms of copy paste: 
– Paste

– Paste values

– Paste link

• What is a worksheet
– When to use multiple spreadsheets vs. multiple worksheets

– How to reference data in other spreadsheets or worksheets (cross 
references)

• How to prevent errors using data validation

After This Section You Should Now Know (4)

• How to use basic statistical formulas: sum(), average(), 
min(), max()

• How to use counting functions: count(), counta(),
countblank(),countif()

• A lookup function: vlookup()

• A conditional counting function: countif()

• The ‘if-else’ function

• Logic functions: and, or

• Using the output of one function become the input of another 
function, example: and, or in conjunction with if-else

• How to use basic statistical formulas: SUM(), AVERAGE(), 
MIN(), MAX()
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After This Section You Should Now Know (5)

• How to use counting functions: COUNT(), COUNTA(),
COUNTBLANK()

• A lookup function: VLOOKUP()

• A conditional counting function: COUNTIF()

• The ‘IF-ELSE’ function

• Logic functions: AND, OR

• Using the output of one function become the input of another 
function, example: and, or in conjunction with IF-ELSE

• How to apply conditional formatting to a spreadsheet

• When to use pie charts vs. bar graphs vs. line graphs

• How to use graphs in Excel

Images

• “Unless otherwise indicated, all images were produced by 
James Tam
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